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*Note: Some screenshots may be of older software versions but the
same integral Ul components as the new version are retained
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1. Computer Requirements

To run this software, the following are required:
e 64-bit version of Windows 7 or 10
e 4GB RAM, 2GHz processor, 200MB free space

2. Installation

When downloading the FabCreator installer, Windows and other software might warn you that this
program is not safe. Click through to ignore these warnings. NOTE: This is not malware, this is simply
software we created in-house but have not yet had certified.

Double click on the installer. On Windows 10, you will see another warning: “"Windows Has Protected
your PC” Click More Info then Run anyway to accept and continue installation.

During installation, follow the dialog boxes to set up initial preferences, do not uncheck INstall MFC
Libraries on the Choose Components dialog window.

(1 FabCreator 2.0 Setup = 2

Choose Components e
Choose which Features of FabCreator 2.0 you want ta install, K g )

Check the components you want to install and uncheck the companents vou dan't want to
install. Click Install to start the installation.

Select components ko install: FabCreatar (Required) DR

[ 4dd to PYTHONPATH
Install MFiC Libraries

Space required: 558.7 MEB

< Back ” Install ]| Cancel

Once the program has finished installing the dialog boxes will close and you can start up FabCreator
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3. Running

3.1. On Launch

When you first open FabCreator, there will be an empty window, as shown below. Under File, you can
either Open (Ctrl+O) an existing .FAB file, or Import (Ctrl+l) a DXF or DWG file.

NOTE: If the icon toolbars are not visible, you can toggle them by right clicking under the File toolbar and
checking File and View

&> FabCreator
File Edit View Windows Help

i - i |
WBREE & O%-2- T Hw
&> FabCreator - —
4 [ o
File Edt View Windows Help RS R AT 0 0o —
Report view = = = ———]
Tree view IC‘,"D'?‘?,‘!'W"E', ‘ Tree view
Part Edit Properties Process Job SeleAion vView Part Edit Properties Process Job Selection view
Labels & Attributes B comboview Labels & Attributes B combo view
Application Python console Application Python console

View

g

o Customize..

e Customize...

3.2. Preferences

You can access FabCreator settings through Edit > Preferences. FabCreator is undergoing Factory
revisions that will simplify Preferences by removing historical artifacts that are no longer relevant to users
and the .fab file workflow. Most of the currently visible options can either be ignored or left at default
values. The pertinent sections you may want to adjust are all located in the General icon and are
described below. It is not recommended to change any settings you do not understand under the Part
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Design, Display, Draft, or Sketcher icons. Those sections primarily contain information used rarely for
Factory troubleshooting.

To reset all changes to Factory defaults, click st below the left-hand icons. To reset just the

k Reset to defaults

changes in the tab you are viewing, clic if it is available.

3.2.1. General

The default view of Preferences is the General tab under the General icon, where you can set Language,
Main Window appearance, and dimensions to reflect your Machine Properties. Most of the Machine
Properties default values are set according to standard FabLight manufacturing dimensions and do not
need to be changed. FabCreator uses these values to check files for parts that are too big or small to
properly load or run in the machine.

In cases where your dedicated application is always on stock material that is within FabCreator’s default
min and max values, it can be helpful to adjust those values to make personalized use of FabCreator’'s

file verification feature. Properties that may be appropriate for you to personalize are explained below:

Tubes

Property Range Explanation

Max Tube Length | < 52in The FabLight rotary space accepts tubes of lengths up to 52 inches.
You may only lower this value.

Min Tube Length | = 0.001in | See “Tube Waste Material” below. You may only increase this value.

Round and = 0.5in The standard FabLight rotary jaws accepts tubes of down to 0.5 inches
Square/Rectangl in outer diameter. This applies to all the accepted shapes: round,

e Tube Min square, and rectangle. You may only raise this value. If you wish to run
Diameter a smaller application, contact us to request personalized jaws and we

will try to work out a design for you. Refer to section “7. Service
Through Freshdesk”

Round and < 2in The standard FabLight rotary jaws accepts tubes of up to 2 inches in

Square/Rectangl outer diameter. This applies to all the accepted shapes: round, square,

e Tube Max and rectangle. You may only lower this value. If you wish to run a

Diameter larger application, contact us to request personalized jaws and we will
try to work out a design for you. Refer to section “7. Service Through
Freshdesk”

Tube Waste = 1.5in Due to interference between the rotary chucks and cutting head box,

Material the available job space on a tube starts after a 1.5 inch buffer space

from both rotary chucks. That means the stock tube that is loaded must
be at least 3 inches greater than the size of the job so there is material
for the machine to clamp onto. This dedicated material space becomes
waste for discard after the job finishes. You may only increase this
value.
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Round Tube 2D | <0.5 2D cuts on round tubes are explained in section 4.4.3. of this manual.
Cut Factor Due to how the nozzle interacts with the tube during a 2D cut, the
Factory recommendation is no greater than a 0.5 factor. This is the limit
for the percentage (as a decimal value) of the tube’s outer diameter
size that a 2D cut can be sized as. For example, if the default value of
0.25 is applied to a file for a 2” tube, a 2D cut feature can only be up to
.5” wide. Exceeding the recommended value can lead to tip touch
pauses or nozzle knockoffs.
Sheets
Property Range | Explanation
Min Border = Qin This is where you can set the default value for margins in the X and the
(XandY) Y between the edges of the stock material and the bounding box of the
job. The margin also applies when you Step & Repeat a part, which is
explained in section 4.5.1. of this manual.
Bed Size Width <50in | The FabLight bed space accepts sheets up to 50 inches long. You may
(X) only lower this value.
Bed Size Depth < 25in | The FabLight bed space accepts sheets up to 25 inches wide. You may
(Y) only lower this value.
General
Property Range | Explanation
Material > 0in Material thickness is only limited by what you can secure down to the
Thickness pallet or rotary chuck (minimum) and what good Factory processes have
(Min and Max) been developed for (maximum). We currently have processes in our
Factory databases for up to .188” thickness for all materials. Please
submit a service request for process development if you have a thicker
application you want to run. See section 7 of this manual for service
information.
Raster DPI N/A The FabLight raster operation works by engraving a certain number of
(Xand) Dots Per Inch (DPI) to fill out a raster shape. The DPI value essentially

represents the resolution of your raster, with greater DPI creating finer
resolution at the cost of longer job time. Lower DPI runs faster but
decreases resolution. You may set these to your preference.

3.2.2. Material Database

Your FabLight will be shipped with the most recent Factory database. We will also email you a copy of
that database file (.db extension) to download for FabCreator use. To load a database file into
FabCreator, go to Edit > Preferences > General > Material Database tab. Your FabLight will be one of
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three power levels we manufacture: 1500, 3000, or 4500. Click on the D button next to the appropriate
power level to specify the location of the database file on your computer.

See section “3.3.4. Units” below for guidance on how to add material to a loaded database.

3.2.3. Units

You can select the unit system and number of significant figures for the overall FabCreator system. This
applies to everywhere in the software EXCEPT the Properties tab of the job file you are making at any
given time. The purpose for these two settings being unlinked is to enable users to enter the job
properties in the unit system that the stock material was bought under, and process the rest of the job
settings in the unit system they are personally used to. For example, if a European user familiar with the
metric system wants to make a .fab file for stock material sold under the imperial system, they can fill out
the Properties tab to match material dimensions easily in inches then arrange the Process and Job tab
settings in their native millimeters.

Combo View

L+

Part Edit Froperties Process Job

units Dxf/Dwg import

Database General Material Database Document Output window
ol £ Units settings
Catalog User units: Metric (mm) T

Units: ® inches (O mm Number of decimals: |3 2
General

Type: >
—==al
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NOTE: The unit system you select in the job Properties tab applies both to the material dimension values
you enter as well as what matching process is pulled from the database loaded in FabCreator. Please
verify you have the correct Catalog and material dimension entries in your loaded database for unit
system you are using.

1313

To pull up the active database, click the icon in the toolbar. In the screenshot below, there is only
one wall thickness option available in imperial units for a stainless rectangle typical tube because there is
only one entry under that directory in the database. To add entries, navigate to the appropriate level in
the directory tree and use the available buttons in the “OK” toolbar.

Fart Edit Properties Process Job

Database

Add Row Delete Row Copy Rowr

FL4500

Catalog v FL4500
Units: @ inches () mm v IN
_ Sheet
rps: e » Round Tube
Shape: RECTANGLE > Square Tube

Material: STAINLESS_304
Material Type: TYPICAL

v Rectangle Tube
v STAINLESS_304

x v TYPICAL
Tube Properties —— v Cut
ﬁ i Rectangle 2.0"(A) x 1.0"(B), 0.19" radius, 0.125" wall
Short Side (B): |1 -
B > Engrave
Wall Thickness s Raster
I:‘ Rotate Wrap 90° e
(@ Corner Radius () Custom  |0.19 -
() Tube Diagonal 2.079 =
Tube Length: 3
3.2.4. Dxf/Dwg Import Tab
<2 Preferences ? =

Document Editor Output window Macro | Units | Dud/Dwg import : L4

Import settings

Join tolerance 0.2 mm
Tube wrapping tolerance 0.2 mm
General Splines
Segment length 0.25 mm
D Reset to defaults
)
Display

Firstly, FabCreator checks imported files for entities that are within the “Join tolerance” value (default
0.2mm) distance from each other and automatically try to join them into a single entity. If those close by
entities are themselves smaller than the “Join tolerance” value, you will see the Join Warning below upon
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importing a file because FabCreator will not be sure which end of each small entity to attempt the join
from.

X

&% loin warning

File contains entity srnaller than join tolerance of 0.2 rmm,
!'- It could cause joining issues,
Please check if wou selected right units for the file,

[ ok

If you hit OK and the file looks ok, you can proceed. Otherwise, you can either lower the join tolerance or
make the small features on your drawing larger.

Secondly, “Tube wrapping tolerance” (default 0.2mm) is how close you have to get white dotted
bounding box around an unwrapped tube for it to indicate, by turning orange, that gaps will be
successfully healed upon wrap. Refer to the bottom of section “4.3.4. Tube Properties” for more details
on wrap matching.

Finally, FabCreator imports splines as polylines in segments set by the “Spline Segment length” (default
0.25mm). A smaller value results in smoother recreation of the spline but at the cost of longer job time. A
higher value allows the job to run faster by replicating the spine in fewer segments.

3.3. Importing

During import, pick the units that match the file being imported. If you created the file in mm, select
Millimeters. A checkbox also allows you to move the part to the origin. This is recommended if you
created the DXF with an origin not at the corner of the “bounding box” that would enclose the part. The
Auto Place setting will automatically move the imported object outside of any existing object previously
imported

Uinits

@ Inch D mim

Placement
Mowe to origin before placing
Auto Place

Ok Cancel import

Here are two images showing an imported part. On the left is with “Move to Origin” checked, and on the
right it is unchecked. Notice how the part on the right is below the black line grid that represents the
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cutting bed. In general, it's recommended to check “Move to Origin” for imports. (It is also possible to do
“Move to Origin” under the Properties tab if you forget.)

BEE
i e

L T —
L

FrRe—
W Ve e 1 STU] R M B
[

L Y =

P

Left: “Move to Origin” checked on import. Right: Unchecked, drawings origin is below bed

This example part is a mounting bracket cut from flat sheet metal for use on the FabLight. It includes two
slots for adjustment, two holes for mounting, and a bend line. We'll use this as the main example in this
manual, with a few other tube examples mixed in.

3.4. Mouse Navigation

On all FabCreator screens, you can interact with the view of the part in two ways:

@«
an se the Mouse Scro eel (or Middle Button) to click an
P . ) Use the M Scroll Wheel (or Middle Button) to click and
(X -Y plane) drag.
4
- . : . :
Hold down the Shift key and right-clicking and moving the
Rotate . ¢ » mouse. . : ,
Shift + This is especially useful when looking at a tube preview on the
e Job Tab, covered below.
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4. Tab Workflow

Once the part is imported, it is displayed with five tabs on the side panel: Part, Edit, Properties, Process,
and Job. The concept is that you move from left to right along the tabs, and set the file up for export.
When you first import a part, the Process and Job tabs are grayed out.

| Part Edit Properties Process Job

4.1. Part Tab

After importing, the file is displayed in the Part tab. A tree structure can be seen in the sidebar.

4.1.1. Process Groups

Expanding the tree structure reveals the process groups Cut, Engrave, and Raster and Reference.
Further expanding each group reveals the Geometry items within. The color in the tree matches the color
on the image:

e green represents geometry to “Cut,”

e red represents geometry to “Engrave,”

e blue represents geometry to “Raster” engrave.

e Black represents geometry that will not be cut.

In this example, the red dotted bend line will be engraved, and the rest of the green geometry will be cut.

&

]
Cardn dew

Fwi Gl Propeies
Limain & Bi nbean
Apghcatun

= i Pl patiers - B -A30E- B St Wi
Past

Green: Cut

Red: Engrave

% ® 5 Pl pafe - D I0- Lk St eeinl : 1 D)

137 o L s

4.1.2. Choosing Geometry ltems

Each geometry item can be selected, either in the tree or by directly clicking in the image.

-y
Multiple geometry items can be selected using the Group Select icon {YZS in the icon bar and dragging a
box around the items.
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Holding down the Ctrl key while clicking multiple items -- either in the tree, or directly on the image --
allows all of those geometry items to be selected at the same time.

4.1.3. Changing the Process or Cut Order of a Geometry ltem

Geometry items are cut/engraved in order from top to bottom. You can drag and drop geometry items to
change cut order.

The geometry items can be dragged between groups, and the color will change appropriately. Compare
the picture below to the picture above, and see that the small circle is now red instead of green, since the
Circle1003 geometry has been moved from the Cut group to the Engrave group. In addition, the large
circle is now blue, since the Circle1004 geometry has been moved to the Raster group.

r =T
L= e = 3 @

EEE .. . ik - iy QB @ TG WGH S
cwm |l | Popue | Ross | ke

abais S dmxvibadni

Blue: Raster

Apphoanar

Green: Cut

Red: Engrave

L 5 Pk pastim - 060000 | B Shast Maial : 1% B

FLTRL N TR

4.1.4. Some Notes on Raster
Any geometry in the Raster Group will be treated as a raster image and filled in if it is a closed shape

Raster images are automatically joined so they will not go in the order of the raster tree. If adjacent raster
images are within 1” from each other, they will be rastered at the same time as a group. All raster images
are automatically dithered around the edges.

The filling of raster parts is simple. FabCreator uses Island Detection to determine what areas will be
filled and what areas wont. If you have a circle within a circle in the raster folder, only the area between
those two circles will be filled.

The Raster DPI (dots-per-inch) can be set for X and Y under Edit > Preferences... > General tab, at the
bottom. The X-axis DPI is the one that determines the speed of the raster, with higher dpi meaning it will
go slower and take longer. The Y-axis DPI can be arbitrarily high, since the laser is just turning on and off
as it scans across the image. You can experiment with different settings to get the image quality you
want.

Raster DPT (X) 200 dpi
Raster DPT () 625 dpi

Reset to defaults
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4.2. Edit Tab

After the geometry items are all in the appropriate Groups, click to the next Edit tab, revealing four
possibilities: Move Part, Move to Origin, Delete and Text.

Combo View

Part Edit Properties Proces (4 ’

| 98 Modify objects

Exr |

o Move [ Rotate Part
|:.[ Move to Crigin

Baanih

A Text

4.2.1. Move / Rotate Part

Move / Rotate part lets you change the position and orientation of parts.

Combo View

Part ¥, Edt Properties Procid ’

. [ Move Part
Position
% (in) ¥ (in)

fox oz |

(e [[=][+][¥]

l Maove part to Origin

4.2.1. Move to Origin

If on import the “Move to Origin” checkbox was unchecked, or you have since moved a part, clicking on

Move to Origin gives you four options for repositioning the part relative to the origin: Move to Origin,
Move to X Origin, Move to Y Origin, and Reset Position.
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[*} Move to Drigin

Mave bo Crigin

&

— Move bo X Origin
i Mawe ko Y Origin

Reset Position

B

NOTE: Moving the part to the origin in FabCreator is different from where on the machine the part will
be cut. The origin in FabCreator will end up being the lower-left corner of the “bounding box” for the
part, the soft home. The part itself can still be placed anywhere on the bed of the machine by jogging
the cutting head.

4.2.2. Deleting ltems

Directly clicking on geometry in the image and then clicking Delete will remove it, as will double clicking
geometry then pressing the Delete key.

4.2.3. Editing Text

If text is imported as part of a DXF, it is automatically assigned to the Engrave group. Under the Edit tab,
if you select the text and then click the Text option (or click the Text option and then select the text), it will
bring up a box that allows editing. This includes bold, italic, alignment, font size, and font itself.

The Bold and Italic buttons will only be available if the font supports it. For a single selection, all edit
features are available. For multiple selections, you will not be able to change the text or the alignment,
only the size, font, bold or italic settings.

For multi-line text, if you change the font size, the space between the lines will be adjusted based on the
new font size. For multiple selections of single line text, the space between the lines is not adjusted.

For fonts, oblique is treated the same as italic.

Click OK to accept any changes.

NOTE: Not all fonts work in this version and there is currently no feature to add new text in
FabCreator.
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Combo View
Part | Edt | properties | Process | Job

€ textengravetestnospecialchars-bo : 1* €3

25.21%29.55 mm

<V>fabfre‘amvk - EE=]
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< textengrovetest nospecialchars-box : 1* €3

2521%2955 mm

Left: Text imported from DXF (“before”)
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4.3. Properties Tab

The Properties tab is where the material the part will be made from is specified. There are four main
sections: Database, Catalog, Sheet Properties, and Engrave & Raster Settings.

Database

Catalog

Sheet
Properties

Engrave &
Raster
Settings

r-ﬂ-{ilmiu-r

L

a2 .. %~

[t e

Pat | Bt Propemes | Beooss | % |

t-a:!;ue
FLLEDD

Cataing
Linies L
[ SELT

Pl TR LAy

Maeral Frpa  FFRCAL

Platerad

o difc Thest Tgw

[
o Cwlalt

Bipshas Semngs
o [efmlt

Accept

Feummc L L

v AQR@IwWTI IIH S

5 Pist patter - 0402003104 Shest Metel | 1% B

=20 ]

S1M =500 mm

4.3.1. Database

In the Database section there is a drop-down menu with the three FabLight models: FL1500, FL3000,
and FL4500. Pick the FabLight model you have, and FabCreator will remember it until you change it
(even after closing FabCreator).

Database

| FL3000

5

If you choose a model and FabCreator can’t find the database for it, a file location dialog box will appear.

To edit a Database, see “Editing Materials In a Database” later in this section.
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4.3.2. Catalog

The Catalog section allows you to pick a material from the chosen database. The choices include:
e Units: inches or mm. Refer to section “3.3.4. Units” for details on how this selection differs from
the unit system you selected in Preferences.
e Type: Sheet or Tube
o Shape (tube only): Rectangle, Round, or Square
e Material: This is the overall material such as stainless steel, copper, aluminum, etc.
e Material Type: This is the specific material variation, such as 304 Stainless

Catalog
e Units: @) inches ) mm
Units: @ inches 0 mm Tvpe: [TUBE v]
Type: (SHEET - Shape: [sQUARE -
Material: | STAINLESS -] Material: |sTAINLESS - |
Material Tvpe: [304 v] Material Type: [304 "']
Sheet Catalog Tube Catalog

4.3.3. Sheet Properties

When the Sheet Type is chosen in the Catalog section, the Sheet Properties section lets you choose the
material thickness.

By default, the “Auto Sheet Size” box is checked. The bounding box is shown in white as the minimum
rectangle needed to enclose the part (see below left). To see if your part will fit onto a specific sized
sheet of material, uncheck the box and type in the X and Y dimensions of the sheet (below right).

Sheet Properties - Sheet Properties —

Thickness:  0.025 - Thickness: 0,025 ¥
EH 12 A |2 i
v: | 1.60206 -] Yoz x

Auto Sheet Size [T Auto Sheet Size

Auto Sheet Size Specified Sheet Size
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4.3.4. Tube Properties

When the Tube Type is chosen in the Catalog section, the Tube Properties section lets you pick the tube
dimensions, wall thickness, and other properties depending on the tube shape.

Tube Properties

Diamneter (A): I1.5

)

wiall Thickness (C): |0.065

kil |

©

Round: Only the Diameter and Wall Thickness
can be specified.

For all tube types (round, square, and rectangle)
the Tube Length is optional, and can be used for

Ry Eorrer Ratlius:: @) Euston | ) previewing the job in a way similar to Auto Sheet
Tube: Diagonal : Size, as described in Sheet Properties above.
Tube Length: 1% Auko L
Tube Properties Square: The Width and Wall thickness can be
A Width (A):|0.5 x| specified.
wall Thickness (C): 0,085 - |
B In addition, the Corner Radius should be
_ pre-defined based on the type of material. It is
W Cothmadus: M Qs (E z) possible to override the corner radius by choosing
& b Didgonsl - i Custom and filling in a value. An alternative is to
ket WAk 1.2 pick a Tube Diagonal (or enter one in), which
grays out the Corner Radius (and vice versa).
Tube Properties Rectangle: This is very similar to Square, except
A Long Side (A): | *| | the Long Side (A) and Short Side (B) are entered
E Short Side (8): | 1 -] separately.
B Wall Thickness (C): [0.0650 -]
[ bake Wrap S0 There is also a check box to Rotate Wrap 90
@® ComerRadus @ Custom 0.1 - degrees. The A and B values stay the same, but
® Tube Diaganal 3153 they are essentially swapped on the wrap. You'll
Tube Length: ] Auto 6.7717 see the corner lines in the drawing adjust
appropriately.
Tube Properties
—B Long Side (A): |2 V]
t Short Side (8):[1 -
y Wall Thickness (C): [0.0650 -]
[¥] Rotate Wrap 90®
@ Corner Radius ) Custom [0.1 vJ
) Tube Diagonal 2,153 .
Tube Length: [¥] Auto 26.7717

on square corners.

A Note on Corner Radius: The actual value of a corner radius can vary greatly from one tube
manufacturer to another, especially for stainless steel and steel square tubes. The default value is
meant to be a value that works for many tubes. It can be changed if your part is having trouble cutting
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If you use the Weldment Library we provide with the Solidworks Plugin, the corner radius is

predetermined for square tubes as follows,

based on the wall thickness:

Wall Thickness (in) Corner Radius (in)
0.065 0.07
0.120 0.13
0.180 0.25
0.250 0.38

If you are not using our weldments you may need to calculate your own geometry.

Since FabCreator imports 2D drawings, the

match the perimeter of the tube it will be cut on. In order to help visualize this, FabCreator shows a white

“height” of the part drawing for an unwrapped tube must

box to represent the unwrapped dimensions of the tube as chosen in Tube Properties. In the images
below, there is a 0.5-inch round tube file shown, first with a 1.255-inch tube selected (note white box is

way too long), and then with the correct 0.5-

inch tube selected. Also note the orange dashed line that

FabCreator overlays onto the part to indicate that it will wrap exactly around the tube.

&> fabcreator

[=]=] = |

File:  Edit— Wiew

i

EBRX -~

Combia Yiew

nddows— Help

—J

Part | Edt | Properties | process | b |

- o || B

v RO N@ I AIH S

Database
(L1500

Catalog
Units:

(use
[rotnD:
[sTamuEss
Material Type: (304

Type:
Shape:

Material:

J
ol
=)
=)

Tube Properties

A Diameter (A); 1,255 -

wall Thickness (C): (0,045 -

Corner Radivs @ Custom

Tube Diaganal

Tube Length: Auta

Engrave Settings
Default : [DEFALLT
Raster Settings

Default : | DEFALLT

<% Halfinch Round tube-Cut-Extrude2 : 1% £

129.83:x132.90 mm

0.5-inch Round Tube file with 1
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&> fabereator

[=o[=] = ]

File Edit View Windows Help
Y = - B B
wEE ~ [0 =3
|Combo View
Part | Edit | Properties | Process | Job |
Database
[FL1soo -
Catalog
Units; @ inches @ mm
Type: [Tuee -
Shape: [rounn -]
Material  [STEEL -]
Matzrisl Type: [CRS -]
Tube Properties
A Dimeter (a):
wall Thickness (C): 0,065 -
Corner Radius @ Custom -
Tube Diagonal -]
Tube Length: Auto [ -]
Engrave Settings -
(V] Default Process: |DEFALLT -
Raster Settings 5
[¥] Default Process: |DEFALILT -
Accept

NAR@ TWTTIIH S

% HalfInch Round tube-Cut-Extrude2 : 1% [

120.83 % 132.90 mm

0.5-inch Round Tube file with 0.5-inch Round Tube selected -- Just right!
Note the orange dashed lines on each end indicating the exact fit.

For Square and Rectangle tubes, FabCreator shows the corners, and the start and finish of each corner

radius, as groups of three dashed lines. For the example shown, the split line for the unwrap is in the

middle of one of the flat faces, and the four corners can be clearly seen. This is helpful for seeing where

features will show up for each face of the cut.

Again note the orange dashed lines on the two ends that indicate the 1.5-inch square tube is the correct

choice for this part.

(=@ = |

&5 fabcreator
File Edit Wiew Windows Help
¥, = - - 2| B
h § .;. a% |_J &/ || E5
Combo View _
Part | Edt | Properties | Pracess | dob |
Database
[FLao00 -]
Catalog
Units: @ inches © mm
Type! [uee -]
shape: [5auare -]
Materisl:  [STAINLESS -]
Material Type: 304 -]
Tube Properties
N —
2 (A}
© CormerRadus @ Custom 0.t -
) Tube Diagonal |z.083 v
Tube Length: aut E -]
Engrave Settings -
Default Process: | DEFALILT -
Raster Settings
Default Process: | DEFALLT -
Accept

% 1.5in. tube .1 rad, inches : 1* [

RAB@ PJWIHTIIH S

170,43 174,45 mm

1.5-inch Square Tube unwrapped, with corners represented as white dashed lines,
and the wrapped edge as orange dashed lines.
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A note on square tubes: If you're having trouble with geometry along the slit, you can edit your cad so
that the slit is anywhere on the tube, then move the geometry up with the edit tab an appropriate amount.

= A0

Catalog

Units: @ inches O mm
Type: | Tuge Al
shape: |saumRe

Material: | STEEL_CRS

Material Type: | TYPICAL

i File s Help
Tube Properties E E f‘
A Width (A} 1.5 v | == Jo
T = Combo View
Wal Thickn 0.1250
B Part  Edt Properes  Process  Job
B |

© Comer Radius @ Custom Ry, Hide Job Preview [ show slews

O Tube Diagonal 198

B ie Qi IIHL

[] Step &Repeat

%
Process: | DEFAULT
PartSize (6.0
Tube Length 6.0
Process: | DEFALLT

PartCount 1

Offset 6.1

Gp 01
MinBorder 0.0
Auto Fil Tube Center

Apply Delete

Slit located on the corner moved up via the edit tab so that it is still geometrically correct.

4.3.5. Engrave & Raster Settings

The settings for engrave or raster will be set depending on the material chosen. The Default box is
checked to choose settings that provide good, general results. By unchecking the Default box, an
alternative setting can be chosen. For example, you might create a process for a darker appearance
option for raster on stainless. These can be added in the materials database (see Section 5. Editing
Materials In a Database below).

4.3.6. Accept

After all settings have been chosen, click the green Accept box at the bottom. This will activate the
Process and Job tabs.
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4.4. Process Tab

The Process tab currently allows editing of cut “tabs,” which are small breaks in the cut outline that either
keep 2D parts from falling out of thin material, or keep tubes from collapsing as cuts are made.

Clicking on the “Tabs” button reveals a number of options. The default Tab Length is 0.1mm or 0.01in.
This can be made bigger or smaller depending on the application. When you switch unit systems in
Preferences, tab lengths will be automatically converted, including for any changes you had made to the
default value.

Combo View

Part Edit Properties Process Job

~ Tabs Editing -

Click on a tab to start moving it

Tab length (in): |0.01

Delete All Tabs

Reset tabs

4.4.1. Tabs on Sheets

Tabs can be added to sheet parts by choosing the “Insert” button, then clicking on cut outlines where you
want tabs to appear. They can be deleted by choosing the “Delete” button, then clicking on the tabs to be
removed. Similarly, they can be moved by choosing the “Move” button, and clicking and dragging on
tabs.

Combo View Combo View

Pait  Edit  Properties  Process  Job Edit | Properties  Process | Job

Edit Tools | Tabs Editing
Click to insert a tab

o g (o

Delete All Tabs

D Tabs

Kerf Comp ON | 0.0050

Reset tabs
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4.4.2. Tabs on Tubes

For all tubes, tabs are automatically added. These tabs can be moved together, or deleted. Additional
tabs can also be added as needed, especially on cut out pieces that may fall during cutting. The images
below show examples of automatically added tabs for square (left) and round (right) tubes.

Combo View Gombo View

Part  Edit  Properties  Process  Jab Part ~ Edit  Properties  Frocess  Job

| Edit Tools

D Tabs

| Edit Tools
D Tabs
(\ 2D Cuts

Kerf Comp ON |0.0000 in

NOTE: If you try to delete the automatically added tabs, a warning pops up. If you choose to delete all
tabs, they can be restored by choosing the “Reset Tabs” button.

.
T

Delete these automatic tabs?
You can re-add them by
pressing the Reset Tabs button.

[] Do not show this warning again.

canc

4.4.3. Round Tube 2D Cuts

Holes and other cutouts on round tubes will be cut by rotating the tube by default. To create a hole or
cutout that is comparable to a drilled or milled hole, there is a button under Edit Tools for round tubes
called “2D Cuts.”

Part Edit Properties Process Job
Edit Tools ~
D Tabs
Kerf Comp ON |0.0050 | in
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Clicking the 2D Cuts button brings up a “2D Cuts Editing” section.

2D Cuts Editing

Click part for 2D cut.

| Select | UnSelect

Clicking on Select and then on geometry such as holes will outline them in black, which indicates that
they will be cut WITHOUT using the rotation of the tube for the Y-axis direction. That is, the holes will be
through-holes in the tube, much like a drilled hole. Clicking on “UnSelect” and then choosing geometry

will return it to the original green.

&5 Preferences

Part design

Display

=

Draft

NOTE: You can only choose entities in the Cut group.
ALSO NOTE: By default, geometry must be less than the radius of the tube in order to be selected.
This can be increased under Preferences > General > Properties > Round Tube 2D Cut Factor

General Material Database Document Output window Units DffDw 41 P
Language

Change language: English x
Main window

Size of recent file list 4 2

"] Enable tiled background

Style sheet: No style sheet &
Size of toolbar icons: Custom (30px) =

Machine Properties

Tubes

Max Tube Length 52 inch
Min Tube Length 0.001 inch
Round Tube Min Diameter 0.5 inch
Round Tube Max Diameter 3 inch
Square/Rectangle Tube Min Diameter 0.5 inch
Square/Rectangle Tube Max Diameter 2 inch
Square/Rectangle Tube Min Corner Radius 0 inch
Square/Rectangle Tube Max Corner Radius 0.25 inch
Tube Waste Material 1.5 inch
Round Tube 2D Cut Factor 0.4

Click on Done when finished selecting 2D cuts, or Cancel to discard selections.
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4.4.4. Kerf Compensation

Kerf compensation can be turned on by entering a desired value if you want the laser to account for the
width of metal it removes while performing the cut. A recommended value is 0.005 in, or 0.127 mm. You
must hit the Enter button on your keyboard after entering the kerf value for it to be registered and saved
to the Process tab before you switch to another tab. The white outline indicating the bounding box should
offset from the outer green cut lines of the part according to the entered kerf compensation value.

Kerf Compensation direction is determined via island detection. The outermost cut will have the kerf on
the outside, the next cut inside that cut will have the kerf on the inside. This island detection includes
reference geometries from the Part tab, so you may have to delete or add reference bounding boxes in
order to get the kerf compensation on the correct side

Combo View Combo View

Part  Edit  Properties  Process  Job Part  Edit  Properties  Process  Job

Edit Tools

D Tabs
("\ 2D Cuts

~ Edit Tools

D Tabs
( \ 20 Cuts

[ Kerf Comp ON  0.0050 in Kerf Comp ON [0.0050 in
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4.5. Job Tab

After all the geometry has been processed, the final Job tab allows the file to be previewed by clicking on
“Show Job preview”. For 2D pieces, it will highlight the overall part cutout. For tubes it will render what
the wrapped tube part will look like. By clicking show Slews in Job Preview, it will show the paths that the
cut head will take between features.

4.5.1. Step & Repeat a Part

A Slngle |mported part can be Pan . Edit  Properties  Process  Job
arrayed across the sheet by ’“"
turning on Step & Repeat.

My, Show Job preview Show Slews

Sheets take both a X and Y A
. . . 1 x ¥
value for array dimensions while  pam
tubes only take an X value. For SheetSize 5700 | 7495
example, if you want six identical g“o::: % ey
sheet cuts, you could enter ®cw [z =]
values of 2 for X and 3 for Y and oo (I | R
. . [] Auto Fill Sheet Center
hit Apply to see the white o Delete
bounding box update to create a
2x3 array of parts. You can also e
set the gap between parts and RoTime: 17 mis
. STAINLESS_304
margin between the array and Material Type:  TYPICAL

the bounding box. See image to e
see locations of those variables. PartSize:  2.5'x1565"

Min Sheet Size: 5.7" x 7.496"

If you want to maximize the Part  Edt  Properties  Frocess  Job
number of parts you can cut out Job
of a specific sheet dimension, Ry, Hide Job Preview  [] Show Slews
click Auto Fill Sheet and enter e
the sheet size. FabCreator will x .
_ 4
automatically set up an array Patsze [25  |[1s6s  |in
within the sheet size according - RO L
. Part Count 2 3
to your Gap and Min Border =
. OOffset 3.200 1.966 in
values. For Auto Fill Sheet, you @cp [07  Jos  |m
can choose to center the Min Border (0.0 (o |
generated array within your E) At M Sheet certer
.. Apply Delete

sheet space. Clicking on Show
Job preview will allow you to see
the job and its cut, raster, and LT

. . Job Time: 2:44 mins -
engrave lines repeated to fill material:  0.024"

i STAINLESS_304
each box in the new array. MEMEEI VRS & TYPRCAL
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Similarly, if you want six identical
parts cut from one tube in the
same job, you can Step &
Repeat with just an X value and
any other settings or Auto Filling
you'd like.

Part Edit Properties Process Job

Job

\ Hide Job Preview Show Slews

Step & Repeat

x X
Partsze 25 |
Tube Length 18.500

Part Count

O offset

@ Gap

Min Border

["] Auto Fill Tube

Apply

Job Information

| Job Time: 5:51 mins
Material: STAINLESS_304
Material Type: TYPICAL
Round tube 0.5" diameter,
0.03" wall

Step & Repeat: Enabled
Part Count: 6

Part Length: 2.5"
Min Stock Length:

4.5.2. Incorrect Tube Wrapping

Something to look for when you Show Job Preview for a tube file is that the tube hasn’t completely been
wrapped, resulting in an unintended cut where the edges meet. This can happen even if the edges of the
tube bounding box turn orange on the Properties tab, which indicates a size match.

Part  Edit  Properties  Process  Job

Database
|FL4500

Catalog
units: @ inches () mm

Type: | TuBE il
Shape: |ROUND -
Material: 1008_CRS v
Materfal Type: HQ

Tube Properties
A Diameter (A): 0.866
Wall Thickness 0,08

Corner Radius Custom 0
Tube Diagonal 1225 ~+

Tube Length: 104961 |

Engrave Settings
[] Default Process: DEFAULT  ~

Raster Settings
Default Process:  DEFAULT ~
Dpi X: [200

bpiv. s |

Copyright 3D Fab Light, Inc., 2021

Part  Edt  Properties  Process  Job

Job
Ry Hiide Job Preview Show Slews
[J Step & Repeat
x
PartSze 105 in

Tube Length 1.05 in

Part Count 1

Offset 12
Gp 015 in
Min Border 0.0 n
Auto Fill Tube Center
Apply Delete
Job Information

Material: 1008_CRS

Material Type:  HQ

Roundtube  0.866" diameter,
0.08" waall

Partlength:  1.05
Min Stock Length: 4.05"

Kerf Comp value:0.005
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This mismatch might be caused by an unidentified error in the DXF in the edge areas. For example, the
polylines may not be properly joined or extend past the corner where they meet.

s @ HEY-

Sheet M

Modiy Annotations

Cut-Extrude? scaled tin.dwg™ X | =

Automalic save to € \Users\twang\AppData\LocalTemp\DrafiSight._autosave\Cut-Exirude2 scaled 1in_8660_1.ds$

DraftSight 2018 x64

N 8 = (&[5 (58] (Amotation -] (1) (120314000

Zoom into the edges of your file and check for any mistakes in the design. Once those are corrected and
all edge lines meet and close properly, the tube should wrap successfully.

Pat  Edit  Properties  Process  Job
Job

Wy, Hide Job Preview

[ step & Repeat

onnes J0b Information

Materia 1008_CRS

Material Type:  HQ

Roundtube  0.866" diameter,
0.08" wall

§ Partlength:  1.05"
: Min Stock Length 405"

Kerf Comp value:0.005"
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4.5.3. Make and Save the .FAB File

After viewing the preview, clicking on the MAKE AND SAVE button will prompt you to save the
FabCreator file.

Job Information

Material: 0.016" o
ALUMINUM_6061
Material Type:  TYPICAL

Step & Repeat: Enabled
Part Count: 2x3=6

Part Size: 2.5" % 1.565"
Min Sheet Size: 5.7" x 7.496"

— £

As described in Mouse Navigation, the preview can be:
e panned in the X-Y plane by using the Mouse Scroll Wheel (or Middle Button) to click and drag.

e rotated around by holding down the Shift key + right-clicking and moving the mouse.

Sheet metal
part & preview:

852, 05-0-QHe
a9 26836 S

Make
and Save

Make
and Save
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© fancreato

Square &
rectangle tube
part & preview:

WER .. [5-
Wa e BE0

ce

EEETRY

Round tube b
part & preview:

Make
and Save

-eHe

&% oms-
9 TOBIBEE S

)

Q-

MY
CR LTI TR
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5. Editing Materials in a Database

If you want to add or remove a material, you can edit the database by clicking on the

Lo
)
P

toolbar. This will edit the database currently selected in the Database section of the Properties tab.
Alternatively, you can go into the Edit > Preferences... menu, and in the general section under the

Material Databases tab click the

Edit

button to edit that database.

icon in the

Thickness button |@ , and a new

line appears with a 0. If you double-click in
that box, you can enter a new thickness.
This is how you can build up a list of
custom thicknesses.

OK.

] [AddThidmass] [Delebe'rhickness] [CopyThidmass]

The database is a tree structure that follows <5 C/Users/charlie johnstone/ AppData/Local/FabCreator/4500 processDatabase_TEST.db =)
the Catalog hierarchy from the Properties [0k A rickness] [elete Thickness] [Copy Tickness]
tab. In this example, it is showing: i ]| s |
e Database: FL4500 s TR e
e Units: IN e
e Type: SHEET s
e Material: ALUMINUM_6061 i
e Material Type: TYPICAL , STawices 34
e Process: CUT e
e Thickness: 0.125 ) gmﬁiﬂfﬁjﬁibe
Sheet
i i
To add another thiCkneSS, click on the Add Ci/Users/charliejohnstone/AppData/Local/FabCreator/4500 processDatabase_TEST.db =

4 FLA500
4 N
4

Sheet
4 ALUMINUM_ 6061
> ANODIZED
4 TVPICAL
Cut
Engrave
Raster
> TYPICAL
> STAIMLESS_302
> STAIMLESS_ 304
> STEEL_CRS
Round Tube

> Square Tube
> Rectangle Tube
4 MM

Sheet
Round Tube
Square Tube

- Thickness

1| I (S

2(0125

m
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If you Single-CIiCk the bOX, you can click the  C:/Users/ charlie johnstane/AppData/Local/FabCreator/4500 processDatabase_TEST.db ==
. : Ok | [add Thickness| [Delete Thidmess| [copy Thickness|
Copy Thickness (€%P¥ Thidkness| - Dejete + i A
a TN
. Delete Thickn 4 Sheet b
Thickness buttons (to copy or 4 ALUMINUM 6061 201z
. > ANODIZED
delete the thickness). « TCAL
Engrave
Raster
This same prmmplg of adding, editing, e s
deleting, and copying works across most | e
elements of the database. it
> Rectangle Tube
4 MM
For Cut, various thicknesses can be added. b
Square Tube il

For Engrave and Raster, there is always a
DEFAULT process, but variations such as
DARK and PRECISE can be added, with
variations in the processes.

The Tube processes are very Similar, < C:/Users/charlie johnstone/AppData/Local/FabCreator/4500 processDatabase _TEST.db =)
except that Cut values require a dimension, [ o< ] [ adembe | [odewbe | [combe |
a wall thickness, and a corner radius (for i +| e | wallThkness(c) | comer Radus
square and rectangular). e o o =
Wl
And things are exactly the same for metric T
(MM), except the values are entered in B3
millimeters instead of inches.
STEEL_CRS
4 Rectangle Tube
> NEW MATERIAL =
4 MM
Sheet
Round Tube
Square Tube
Rectangle Tube =

5.1. Stock Properties DB File Location & Management

You can point to a DB file in another folder by clicking on D and finding one. It doesn’t need to be in
that hidden AppData folder. But it can be useful to know how to find it.

5.2. A Note About the Materials on the Machine

When you add materials in FabCreator, the process table on the machine’s HMI will not know about
them. When you load the file onto the HMI, you will be presented with the opportunity to create a new
process by either copying an existing process for adaptation, or by entering a new process entirely. See
the FabLight Operator's Manual for more on creating processes on the HMI.
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6. Running a FAB File

Copy the FAB file to a USB flash drive, and bring it over to the FabLight. Refer to the FabLight Operator’'s
Manual for instructions on how to run the job on the machine.

/. Installing a Newer Version of FabCreator

New releases of FabCreator will be provided by a FabLight technician.

NOTE: We don’t yet have automatic checks for newer versions.

To find out what version you currently have installed, go to the Help > About FabCreator menu. There
you will find the version number and release date of your install.

About Credits License Libraries

<> fabcreator

FabCreator @ Copyright(c) 2017-2018 by 3D Fablight Inc.

Version 21

Revision number o

Build number 92

Release date Tue 01/29/2019

License... Copy to clipboard |

8. Service Through Freshdesk

If a file is giving you trouble, or you need help processing it, you can attach it to a ticket on Freshdesk.
Please include any relevant Solidworks or imported DXF files. You may also submit tickets about
FabCreator bugs or feature requests through Freshdesk.

You can create an account here: https://3dfablight.freshdesk.com
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